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This presentation explains how to extend IBM WebSphere Development Studio
Client for iSeries to add your tools.
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What is Eclipse?

= Eclipse is an empty slate: ﬁJ
— Except for the Java tools it supplies -

— Use it to build AD products

— By writing "plug-ins" that offer tools for particular programming
needs

— Plug-ins "snap into" Eclipse seamless
— Eclipse + useful plug-ins = product
— Common base for all new IBM AD products
— Common base for many new 3rd party products

= Eclipse is an opportunity
— To build and sell plug-ins for all eclipse users
— All users of Eclipse and Eclipse-based products

© 2003 IBM Corporation

So what is Eclipse? With the exception of the built-in Java tools, Eclipse itself is not
that interesting. It only gets interesting when you add to it some plug-ins (for
example, tools) that do something interesting.

An Eclipse-based product is Eclipse plus a number of interesting plug-ins. IBM is
building numerous such Eclipse-based products, including as we have seen Site
Developer and Development Studio Client. Further, because Eclipse is free and
business partners are free to include it in their products, there will be many other
Eclipse-based products from other companies too, including Rational and
TogetherSoft.

For business partners or software developers who write and sell application
development tools, Eclipse is a fantastic opportunity. By writing plug-ins for Eclipse,
those plug-ins can be sold to any developer using any product based on Eclipse or
even just the raw Eclipse as downloaded from www.eclipse.org. This opportunity is
not lost on iSeries tool vendors, who are all looking at offering Eclipse plug-ins for
their tools. This will result in a rich offering of third party plug-ins for developers to
choose from, all of which extend their core Development Studio Client development
environment. One community, one core development platform, many IBM and 3rd
party tools. This is community and excitement!
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Eclipse Open Source Organization

*An open source community chartered to
manage the evolution of an open application

development integration platform P e
[ ; An Open,
. . | = Extensible Tools

*Managed by an independent, multi-vendor =3 Integration Platform

organization ‘\
* Technology licensed via the Common Public IBM

License Technology

Contribution

*Based on Java with initial support for Linux &
Windows

feclipse

*Broad Industry Support

www.eclipse.org
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Eclipse was developed by IBM and donated to the open source community. That
donation is estimated to be worth $40 million. Anyone can download Eclipse for
free, including the source code, from www.eclipse.org. Eclipse has generated
extraordinary excitement in the development community and the tools community. It
is written in Java, and can be extended by tools that are also written in Java. These
tools are known as plug-ins. Out of the box, Eclipse offers an integrated
development environment (IDE) that has built-in support for teams and projects and
a robust and revolutionary user interface framework. It also has tools built-in to
create Eclipse plug-ins. Further, there are extensive and very powerful tools built-in
for developing Java applications with Eclipse. So, if all you want is the world's best
Java toolset, then all you need is Eclipse. You can't beat the price!
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Eclipse Workbench

Java Type Hierarchy
P ug-in Development

A 'Portal-like’ Tool Integration Platform

[ Resource
R . 3 Soripts
A personalized, extensible Ty server

development platform organized via %If:;

developer et (cofautt)
P 2 L

"Perspectives"
OK I Cancel

[4]

Java IDE

---"7; Products built e,
I with Eclipse Project Management
inherit these Eclipse b
capabilities plus ' Debugging
'plug-ins’ built Workbench Services
— by others i g

Plug-in Services & Tools

Desktop & Help
diNewo

¥
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Some of the common services Eclipse supplies include: the Java integrated
development environment (IDE), project management, debug, plug-in frameworks,
desktop and help frameworks, and resource managers.
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Eclipse — Broad Industry Support

Over 135 companies have been involved in the Eclipse project,
including these industry leaders ...

Altoweb Neuvis Aldon

Bowstreet QsSL MKS .e cli pse
BrowserSoft Rational Softlanding

CommerceQuest Red Hat Lansa www.Eclipse.org
Computer Assoc. Serena ASC

Compuware Sitraka

Crystal Decisions Skyva "This has long been a dream of developers,

and now IBM is providing the integration

Embarcadero TeleLogic framework to make it possible.”
Arun Gupta, CTO, Neuvis Software

Holosofx TogetherSoft
2oal "The goal of Eclipse to provide a seamless interface where
Instantlatlons versant developers can leverage tools from multiple vendors is a great
idea and is something that will add value to our customers.
Legach ersata Eclipse is a great way to make it easy for iSeries customers to
N o a co m p I ete integrate and leading tools like
Macromedia LANSA.

Merant I i st ! ! Bill Benjamin

Vice President, Business Development
S ¥ |
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IBM is not alone with Eclipse. The open-source consortium that oversees
contributions made to it include a number of large companies, and that list is
growing. Note that MKS is an iSeries tool vendor. See www.eclipse.org for the
latest list.
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WebSphere Studio Workbench

=Basis of all next-gen IBM AD products. Eg:
— WebSphere Studio Site Developer
— WebSphere Studio Application Developer
— WebSphere Studio Integration Edition
=Available to IBM Business Partners
— Via IBM PartnerWorld for Developers
v To build/test plugins
v To create products

WSNDJE

Each product is a

different "configuration" e
of WebSphere Studio bl
»Refers to product family OcllllSG R

Java

:
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Here you see that Development Studio Client is based on WebSphere Studio Site
Developer, while Development Studio Client Advanced is based on WebSphere
Studio Application Developer.

The Workbench is based on the open-source Eclipse technology about to be
discussed. It is not for sale, but is the basis of all IBM WebSphere Studio products,
and is available to business partners.

Site Developer is IBM’s entry level offering based on eclipse, and it is for building
dynamic Web sites out of non-EJB Java. Application Developer extends Site
Developer and adds support for EJBs. Application Developer-Integration Edition
extends Application Developer and adds support for JCA Connectors and for
Workflow. Enterprise Developer extends Application Developer-Integration Edition
and adds support for S/390 and Enterprise Generation Language (EGL), the follow-
on to VisualAge Generator.
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WebSphere Studio Workbench (WSWB)

A fundamental change in AD Tooling paradigm

*Challenges
Tool Tool * Difficulty of integration
Function Function ~ Different Semantics, Ul etc
= Different repositories
Yool ool = Not best-of-breed Tool Services
Services Services Services » Difficult to manage

= Slow to Market

=Benefits

= Easier integration
= Single view/mgmt

Workbench
»Common look and feel

~ Best-of-breed Tool Services

= Tool builder focus on tool functions
= Fast to Market

10 ‘ Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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New WebSphere Studio Site Developer

*For professional developers of dynamic Web applications & sites

*Delivers integrated support for open Web standards, including Java,
JSP, XML, Rich Media & Web services tools

IBM Server &
Middleware
Tools

Partner Tools
Middleware

WebSphere Studio

WebSphere Studio Workbench

Site

Developer # ) Team Support

Studio Workbench

W j I-*
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New WebSphere Studio Application Developer

*For professional developers of Java & J2EE applications, requiring
integrated Web, JSP, XML & Web services support

*Advanced tools for code generation, performance tuning & quality

*Includes a highly integrated WebSphere Application Server test
environment and deployment automation tools

1sVa
Customer
Tools

Websphere studio [ ' J2EE (EJB, J2C, etc.)

WebSphere Studio Workbench A I ic at i on &
: pp \ ’ Data mapping
Developer

1BM MW &
rver Toolkits

8 4
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New WebSphere Studio Integration Edition

*For developers & integrators of advanced J2EE & Web services

*RAD tools for visual application modeling, composition & adaptability (e.g.,
business rules)

*Advanced EAI tools for generating adapters & dynamic microflows
including integration of remote host assets

WebSphere Studio

Wlbsplu Studio Workbench ] I n t e g rat i on

as : Visual Builder for Adapters
Edltlon < & Microflow
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Workbench

eclipse.org

= Perspectives
— Contain views and editors —

— Are named and have default layout of the views/editors

— Are targeted towards a specific type of development, i.e. Java, XML,
Help, Debug, WebFacing, ...

= Editors

— That open, edit, save and close files

— Can contribute to the Workbench menu bar and tool bar
= Views

— That display information

— Can have their own toolbars

— Updates saved automatically
Miscellaneous
— Actions, Menus, Toolbars, Wizards, Properties, Preferences

W j I-*
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Workspace

= Workspace is the term given to refer to all development resources
currently accessible in the Workbench

= Eclipse Resource Workspace
Resources = Projects + Folders + Files
Projects map to a folder in local file system
Projects contain folders and files
Folders contain folders and files
Projects are typed
Resources are versioned as they change
User can compare and restore versions
Resources can have properties

Properties are displayed in the properties view

W j I-* :
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Workbench Overview Global tool bar
and menu tg_ar

=101x]

&P XML - WebSphere Development Studio Client Advanced Edition for iSeries

it Mavigate Search Broject Run ML Window Help

Open HAE(N ] PR RNy BB [0 7% |6 28 B0k

. = Cutline x || [] PurchaseOrder.xml - X
perspectlves BT (@ o parchasecrde: I - - -, -/, coer, tens)
=) (€] jpo:purchassOrder @® orderDate 2001-01-01

[&] shipTo @ zminsipo hitp: {fuuwu. . com

[€] bilTa @ xminsixsi http: v, w3.0rgf2001 XMLSchema-instance
[€] porcomment @ =siischemalocation hitp: {jwww.ibm. com PurchaseOrder, xsd

= [&] items =-[€] shipTa (name, street, cty, state, zip)
- [#] item @ country us

-] producthlame name Alice Smith
i[e] quantity street 125 Maple Street

-[&] USPrice ity Mill Yalley
1 (€] porcamment state Edt
el 2 Itor
[€] bilTo

(€] po:comment
=-[&] items

Local tool bar
1-[€] item E .
for a view

hame

| esign [ source

WMLEditProject =] Propetties

H (= Invoice Propert | value
Bl & PurchaseOrder Elife
Resources @ ntsrnationsl CET true
R HewFie,arl last modified 20/05/03 £:34 P
name PurchaseCOrder xml
path [¥MLEditPrajectjPUrchaseOrder[PurchassOrdar xml

1081

| Tasks | Properties | )
| kL Eritproject/PurchaseGrder Purchaseoraer:

-'r- j I-*
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The Eclipse workbench has four open perspectives. You can see them lined up on
the left frame of the workbench. The current active perspective is the one whose
icon is indented, which in this case is the Java perspective. To open a new
perspective, you use Window->Open Perspective giving you the Select Perspective
dialog that you saw previously. This particular perspective has a Package Explorer
view which drives the Editor and the Outline view.
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Start by opening a
perspective based on the
type of development they

Using Eclipse

are working on.

=
Select
Select 2 wizard

- Comparent Tast
bam
£l
e ieries
~12EE
-

Then create new resources
(projects, files and folders)
using the “New” wizards

" nk
Plugin Develosment

~Remote Fie Transfer

~Server

~sriple

- Swiptom Databass

7 Web

~WehFacing

- Web Services

(@ zaurcs Fakder

Work with your resources using the
Navigator view. The Navigator view shows
all resources. Often it is easier to use a
local view which filters out projects that are
not related. For example the “Packages
view” shows only Java projects.

e il ] 1A
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B 18va Browsing
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<0 Plug-in Development
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Eclipse Team Support

= Users create and work with projects
— Contain folders and files
— Which are versioned as they change
— Are “typed” and have type-unique toolinﬁ

— Are synchronized between local workspace and team
repository

synchronize
Team Repository

R l o

| Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation

Central to the Eclipse integrated development environment is support for projects.
Projects are simply a grouping of folders and files.

Plug-ins have types, such as Java or Web or XML. Tools that plug into Eclipse can
define their own new project types. Tools that plug into Eclipse work against
resources (folders or files) within projects. They can be scoped to projects of a
particular type, if appropriate.

All projects, regardless of type, have common behavior and support. This includes
the ability for a team to share a project by using an Eclipse-supporting software
change management (SCM) product such as Concurrent Version System (CVS) or
Rational Clearcase. This SCM acts as a central repository for one or more projects.
Each team member can easily keep their local copy of any project "in synch" with
the central repository copy. CVS is a free open-source SCM. It runs on Linux, UNIX
and Windows. It comes on the Linux distribution CDs for iSeries Linux LPAR.

All IBM SCM vendors for iSeries are enabling, or have enabled, their products to
Eclipse.
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Developing Eclipse Plug-ins
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Plug-in Development
= You add functions to the Workbench by developing plug-ins

= Plug-ins

— Highest level of organization / structure for adding functionality to the
Workbench

— WebFacing plug-in

— Remote Systems Explorer plug-in

— Web Tooling plug-in

— iSeries extensions to Web Tooling plug-in

— A collection of files which implement your desired function

— Plugin installed by copying your files to a subdirectory of
<root>/plugins
— There are built in tools for installing new plug-ins
— Described by the plugin.xml file

— Eclipse will look for this file in all subdirectories of <root>/plugins

— Describes what function(s) your plug-in is adding to the
Workbench

R ! I.*
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Anatomy of a Plug-in

= Files typically found in a plug-in

<root>/plugins/com.ibm.example/

plugin.xml
plugin.properties
example.jar
example.properties
HelpContexts.xml
doc.properties
doc/

*.html
nl/

en_US/

icons/

W ] I. 4

Add you own tools | Eclipse Plug-in Development

- describes the plug-in

- translatable strings for plugin.xml
- Java code for the plug-in

- translatable strings

- structure for F1 help

- translatable strings for help

- plug-in documentation

- NL versions of .properties files

- graphics files for your plug-in

© 2003 IBM Corporation
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Example Anatomy of a Plug-in

File Edt View Favorites Tools  Help

@Bam | Gpoiders 8 | 5 T X mTele_

AgdreQ@D:\wDsc\.senes\e(hpse\pmgms\mm.\bm.emuls.\senes.mre,s.u.1 )
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{1 com.ibm.etaols. issries. chl40n, dac_S

Folders — g ] [ cesidables
(- com b, etools.iseries.ae_5.0.0 I'D html
[ (Jicons

com.ibm.etools.iseries 1o

3 com.ibm.etools issries.<l.doc_5.0.0
1 com.ibm etools.iseries. codeclef. doc

1 com.ibm. etools.iseries codedit, doc_t s akso:

L3 com.ibm, etonls.iseries codedsn.doc, My Documents

1 com.bm etools.iseries. commean.dot M Wetwork Flaces
-] com ibm. etools.iseries.core_5.0.0 My Computer

£ com.ibm.etools iseries. cop.doc -

{1 com.ibm etools.iseries. crtiva.doc_S.
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-1 com.ibm.etools.iseries javatools 5.0
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{21 com.ibm.etaols.iseries perspective.c
-1 com.ibm,etools iseries perspective_t
| com‘ibm‘etuu\s‘iser\es‘perspectwi"LI

| | » 4|

Select an item to visw its description, [ serverruntime

runtime

A54005ystemResaurces. properties
Edoc zip

HelpContexts. xml

hastprereqs. xml

I5eriesEditarPreload properties

ISeriesEditor Translatedstrings properties
ISeriesEditor TranslatedStringsFormatLines properties
ISeriesEditorTranslatedstringshenus. praperties
iseriesmessages. xml
ISeriesResourcesCodedssist . properties
isvTac.xml

Ish_cobal_ile propertics
Ish_cabal_ile_messages. properties
Ish_cobol_opm. properties

Ish_cpp_400. properties

= ish_dds. properties
Ish_dds_messages.properties

iie.properties
Ish_rpa_ile_messages.prapertics
Ish_rpg_opm.properties
Ish_rpg_opm_ressages. properties

|33 abject(s) (Disk free space: 417 ME)
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Plugin.xml File

= An XML file that describes:
Prerequisite plug-ins
Jar files shipped with your plug-in
Extension points implemented by your plug-in
Declares new extension points added by your plug-in
= Required for every plug-in
= Special plugin.xml editor included in the Eclipse plug-in development
environment

Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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Extension Points

= Allow you to add functions to the workbench
— Declared in the plugin.xml file
— Associated Java code is shipped in JAR files

— First you need to find the extension point for the new function you want
to add
— Workbench extension points are documented in the online help
— Includes the XML DTD for the extension point and example XML
code

Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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Extension Points

Rapid AD Web | | Java Dev Tool | | Plugin Dev
. Env
Tools Tooling (JDT) (PDE)

Standalone
Tool
Desktop
Platform APIs / Extension Points
Common Services Common Frameworks
*Resource Management *Widget Toolkit
Published *Project Model *Ul Frameworks
Extension *Team Programming Model Editing Frameworks
Points +Debugging *Builders, Markers, Help
oo *Extensibility framework \
¥
IBM /lSV [ Other
Contribution Interface Interfaces, WebDAV
B&_lse Repository
Eclipse

8 ¥ |
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Example Extension

& Help - WebSphere Development Studio Client Advanced Edition for iSeries

searchi [ | [E Advanced search

WebSphere softwar

Points

Documentation for
Workbench extension
points is available in

Contents i)

Tool developer information

the online help under

[E 700l developer information
= [ Extending the platform
(B Programmer's Guide
= B Reference
(@ ap1 Reference
=) (B Extension Points Reference
@ Flatform Runtime
B warkspace
(@ workbench

Other Reference Information
1B Examples Guide
B Questions Index

[ Extending the Java tools
1B Plug-in Dewelopment Environment.

[ Help System Example
Bl GEF Developer's Guide
(B orawzD Developer's Guids

‘ Add you own tools | Eclipse Plug-in Development

Workbench

org.eclipse. ui.acceleratorConfigurations
org.eclipse ui acceleratorScopes
org.eclipse i acceleratorSets

org. eclipse. ui. actionDefinitions

org eclipse ui actinnSetPartAssociations
org.eclipse ui actionSets

org.eclipse ui decarators

org. eclipse. ui. dropActions

org eclipse ui editordctions

org.eclipse ui editars

org.eclipse. ui.elementFactaries
org.eclipse. ui.export¥Vizards

org eclipse ui importyYizards
org.eclipse ui markerHelp

org.eclipse. ui. markerResolution
org.eclipse. ui.neviWizards

org.eclipse. ui perspectiveExtensions
org. eclipse i perspectives

Tool Developer
Information

Add your own popup

org eclipse. Ui T
org.eclipse. ui preferencePages
org.eclipse ui projectiNaturelmages
org.eclipse ui propertyPages
org.eclipse. uiresourceFilters
org.eclipse. ui startup
org.eclipse. uiviewActions
org.ecligse. i views
org.eclipse. ui.workingSets

]

menus to the
Workbench

© 2003 IBM Corporation
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Extension Point Documentation

P Help - WebSphere Development Studio Client Advanced Ei o =]

ssarch: [ | [0 Advanced search
Contents B2 | Tool developer information IR =)
[+]

Export Wizards

oper information =
i the platform
rammer’s Guide
Erence .

Hdentifier: orgechpee wexportWizards
AP Reference ﬁ & B 2P

Extension Points Reference L .
b B Platform Runtime Descripgion: This extension point is used to register export wizard

b B workspace wizards appear as choices within the "Export Dialog', and are used [ p g 9 )6 (=1 o 1] ption for
B workbench from the workbench
B org.eclpse.u acceleratorConfiaurs the XML to declare

B org.eclipse.ui.accelerators . . .
irorenalll R b e LI SLEE R e the extension point in
your plugin.xml file

B ora.eclipse. ui. actionDefinitions
B org.eclipse.ui.actionSetPartAssocia

Bl org.edipse ui. actionsets Configuration Markup:
B org.eclipse,ui.decorators
g org.eclpse.ul.dropActions <IELEMENT wizard (description? selectiont]>
org.eclipse.ui.editorfctions CVATTLIST wizard
B org.eclipse.ui.editors
org.eclpse, ui.elementFactories i CDATA #REQUIRED
A TR M B Ay neme  CDATA #REQUIRED
B arg.eclipse.ui.importwizards class CDATL HREQUIRED

B org.eclipse ui.markerHelp CDATL
B ora.eclipse. ui.markerkesolution -
B org.eclipse.ui.newsizards

#IMFLIED

<!ELEMENT description (#PCDATA)>

. Actual XML
id - a unique name that will be used to identify this wizard.
« name - a translatable name that will e used in the dialog box to reprofCR G| o] CEFE (=3

wizard.
class - a fully qualified name of the class that implements shown farther
down the page!

B ora.eclipse. ui. popupMenus
B org.eclipse.ui.preferencePages

(W]
© 2003 IBM Corporation
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Hello World Plug-in Example

Create a new plug-in project

Examine the Plug-in Development perspective

Add a menu and menu item to the main menu

Supply an action for the menu item that displays a message box

Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation

Now lets walk through an example
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Creating a new Plug-in Project

Mew Plug-in Project

Plug-in Project Name

Select the riame of the new plug-in project (e.g. ‘com.example.scyz’). By defaul, this
name will alsa be used Far the plug-n 1D,

-~ Component Test
- Data
EIB
B iSeries
- J2EE
B Java
Plug-in Development
- Riemote File Transfer
o SErVEr
simple:
Symptom Database
- Web
- WehFaring
Web Services
AL
- Excamples

< Fragment Project
L] Extension Point Schema

4> Convert Java to Plug-in Projects
X Feature Project

Use the "New" wizard
to create a new
Plug-in project

Praject name: | com.example.MyPlugin

Praject contents:
¥ Use default

Directory: [ CHDacuments and Settingstyantai|Mly Documents\[EMindscinorkspas  Browse...

By convention your plug-ins
should start with the reverse of
your Internet domain name.
For example: com.ibm...

cga [ wex | Euh | cawel

= Back. I Mext = I Eiriist Cancel

s 1 I. l

Add you own tools | Eclipse Plug-in Development
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Mew Plug-in Project

Plug-in Project Structure

Define essential plug-in structure settings

Plug-in Id

IBM Software Group | WebSphere software

Creating a New Plug-in Project

Mew Plug-in Project

Plug-in Code Generators

[ Eam.example. Myl

in

Select the wizard that will generate the intisl plug-in code:

&

Javabuider output  [bin

" Creats a blank plug-in project

Plug-in puntime library [ MyPlugin jar

Source folder

Awallable code generation wizards

[oe

= Back

% Create a plug-in project using a code generation wizard

9N Custam plug-in wizard

ZNDefault Plug-In Structure

N Hela, World

% Plug-in with a multi-page editor
3R Plug-in with an editor

N Plug-in with 5 popup menu

N Plug-in with & property page

% Plug-in with & view

N Plug-in with perspective sxtensions

This wizard ereates standard plug-in
directory structure and adds the following:

® Action set, This template creates a
simple action set that adds Sample
Menu to the menu bar and a butkon to
the tool bar, Both the menu itkem in the
et menu and the butkon invoke the
same Sample Action. Its role is to
open a simple message dialog with a
message of wour choice.

Extensions Used

* org.eclipse.ul.actionSet

[ wext> | e Cancel

I Cancel

Add you own

tools | Eclipse Plug-in Development
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Creating a New Plug-in Project

New Hello World plug-in pr

New Hello World plug
simple Plug-in Content

Sample Action Set
Enter ths required data ko generats initial plug-in fles ﬁ

This template wil generate & sample action set extension with & menu, & menu lkem E
and a kool bar butkon,
Plug-in name | MyPlugin Flug-in Java Package Mame: | com.sxample.MyFlugin, actions
Version [ton fction Class Mame: | Samplection
Provider Hame | EXAMPLE Message Box Text: | Hello, Eclipse world
ClsssMame | com.example MyPlugin MyPluginPlugin

¥ Add the action set to the resource perspective
[¥ Generate code For the class

Plug-in code generation aption:
¥ add default instance access

[¥ Add support Far resource bundies
¥ add access to the workspace:

< Back net> || Ensh | cancel

ek peis [ Emsn | cancel

Add you own tools | Eclipse Plug-in Development
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Plug-in Development Environment ]

) ; arch Project Run Window Help aeveiop e
Plugin project [EZERINEETT FAENEAEE nerspective

g, Package Explorer v x X I J] SampleAction. java

weloome:
Cwervisw
- [E) Dependencies

|»

B IR MyPlugin Plug-in

- com.example, MyFlugin

#alerts and Action Ttems

Erc)

& -2 lugin.xml

® 3 com.example. MyPlugin| | No alerts at this time. p g . i 2 org.edipse.core,
4] 9] MyPluginPlugin, jav. . E‘ ?; srg‘echpse.u\
= -H com.example.MyPlugin| |~ General Information Ed |t0 r .‘{“p:::luqmw

1] sampleactionjaval | T e general information abot this  The following lbraries will be added to tf
(G ECLIPSE_HOVEjpluginsior | piugin classpath of this plug-in: o org eclpse.ul.sc
{2h ECLIPSE_HOMEjpluginsior - o
l‘Eh ECLIPSE_HOME/pluginsfor Plug-in 1d com.example. MyPlugin Wl HyPlugin.iar Mare. i b= org.eclipse.ui.pe
(G ECLIPSE_HOMEjpluginsford | Plug-in Neme  [MyPlugin Plug-in Bl
{Eh ECLIPSE_HOMEfpluginsfarg | Version

{Eh ECLIPSE_HOME/PUOINSION | proyider hame [EXAMPLE

[ JRE_LIE - D:\Program Files

= Extensions

¥l &

~ Required Plug-ins

The Following plug-ins must be installed f_J

Class com.2xample. MyFlugin.MyPluginPlug|  this plug-in ta work properly:

T 4 ora.eclipse core resources [More.
S org.eclipse.ul

The follawing extensions are defined in this plug-in:

©= org.eclipse. i actionSets ~ Extension

A= rn erclinee i s Fhe
i ; e — |
eXtenSIOn pOInt Welcome 0verwew]Dependennes|Runmme Extensions |Extension Points EDurtD | | »
to provide t Sroes - T W@ v x
Propert: | walue [ <[ | pescription | Resource | 1n Folder =
popup menu
O ed ealtor page O <110 O 0[S e
4 » ) a . a a a . - . - . - -
Package Expl... |Hierarchy |Plug-ins || 4

e Plug-in Developme © 2003 IBM Corporatio
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Defining the Extension

#WEI} - WebSphere Development Studio Client Advanced Edition for iSeries

File Edit Mavigate Sesrch Project Profle Run Window Help

BlE% |- |A-||£EE3 26 B 7 uasfFme
FE-—eL|9e-|g|lad]e] ¢ %-

JZEE Mavigator - x X ] J] SampleAction. java

)

Extensions

o _
T com.sxample MyFlugin
g Pl PP All Extensions Extension Element Children
(2 src
(=& com.example. MyPlugi O show Full extansion hisrarchy =T menu
inFhugin.jay 9= org.eclipse.Ui.actionSets LB separator
L 2

8-} fﬂm‘e"affl'l)'e""'yp'uq‘f %] Sample Action Set (actionget)

1] sampledction. javs 8= org.eclipse.ui.perspectiveExtensions

(& icons %) org.eclipse. ui resourcePerspective {pes
by build. propertiss

Use the “Extensions” o
page of the plug-in
editor to define your
implementation of an [ [ - :
extension po int Welcame | Overview | Dependencies Runtime |Extenzions | Extensian Points | Saurce

[ Properties
Frapest

| valus

accelerator

Or use the source allowL abelUpdate

class
tab to manually enter B
the XML (OUCh)! Tasks | Links | Thumbnail | Styles | Colors | Servers | Console |Froperties | —1

‘ Add you own tools | Eclipse Plug-in Development
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Plug-in Build Path Right click on the
PDE project and

select properties to
get this dialog

&P Properties for com.example.MyPlugin

Info Java Build Path
ieanInfo Path
xternal Tools Builders

% Source | & projects | Wl Libraries 1L Order and Export |
Build class path order and exported entries:
(Exported entriss are contributed to dependent projects)

[ACE com.example.MyFlugin/src) (W]

[ @ ECLIPSE_HOME/pluginsiorg. eclipse. core.resources_2,0,14r o
] @ ECLIPSE_HOME/pluginsforg.edlipse. ui_2.0.2/workbench.jat 4|—°W"
[ & EcLIPSE_HOME/plugins{arg. eclipse. Ui winaz_z.0.0/workbe

?’CLIPSE_HOMEIpIugins/urg.eclipse‘swt.wmﬁZ_Z.D.wasﬂw Select Al
@ ECLIPSE_HOME/plugins/org. eclipse.core.runtime_2.0.2frur Deselect Al

[ @ ECLIPSE_HOMEpluginsjorg.sclipse. core.boot_2.0.3/boot.
[ @ IRE_LIE - D:\Program Files|IBMiwWebSphers Studioieclips)

wradoc Location

ava 1AR Dependencies
roject References

- Terver Preference

- validation

—

ECLIPSE_HOME is a jar files required for
variable that points to the ) >q .
. ; the plug-in to build
directory where Eclipse (SWT, JFace, ...)
(the workbench) is T — 2 ’ -

in t ” : Build output Folder:
sta ed [ com.example. MyRlugin/bin Browse. ..

r i |‘

Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation



Action Class (Invoked by the Popup Menu)

File

Edt Source Refactor

Navigate Search Froject Profle Run Window Hslp

=39

NEENEE

Ie |8 -

lmEa 26

AE-—@EO|Be -

e

EREIECE

[¢ePHdeeld D

=} com.example.MyPlugir
[9] MyPluginPlugin.jay
=-H# com.example.MyPlugit
[3] sampleaction.javz

Wil Libraries

B 1 Connectar Project
155 DefaultEAR

[+ 128 Demo Web Project
-1 iSeries Java Samples
E

jlﬁ Program Call Pmiectl
4

J2EE Mav.., JSErver C... |J2EE Her...

T} Gallery

x

ES

delegated to it

I2EE Navigator v x ||<myeiugin Pug-m x]
R * Our sample acticn implemsnts
* The action proxy will be crea
EMTa# com.example. MyPlugin = # shown in the Then the use
B src *
*
*

@see IWorkbenchWindovictionDelegate
*

public class Samplsiction implemen

actionSet extension point requires
the class to implement the
IWorkbenchWindowActionDelegate
interface

this delegate will be created and execution will be

IWorkbenchiindowictionDslegate {

private IV
P

* The cong]
*

public Sam
+

Gee Also:

[rom.example.MyPlugin.actions.5amp

ur sample action implements workbench action delegate. The action proxy will be created by the
workbench and shown in the UL When the user tries bo use the action, this delegate will be
created and execution wil be delegated to it.

P

*= The action has been activated. The argument of the
action sitting

* method represents the
* in the workbench UI

* @see IWorkbenchWindowictionDelegatedrun

xs

‘real’

public void run{Iiction action) {
MessageDialog . openlnformation(

window.getShell().
"MyPlugin Plug-in"

"Hzllo, Eclipss world"):

——

run method(...) is
invoked when the
popup menu is
selected

asks (5 items)

-
F R v x

| 1 | Deseription | Resource | 1n Folder | Location [ -
Broken Link - strutsEGL Updateficcoun... | struts-confi... TradeTuberialiWeb Content... e 40
Broken Link - fwfprajjservices/ReportS. ..  eservices.css  WebFacing Project/Web Co...  line 21 -

‘Gallery IL\brary | Outline | Web St.. EE || Tasks IL\H\G | Thumbnail | Styles | Colors | Servers | Console

Plug-in Development

Writable Insert

© 2003 IBM Corporation
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Testing Your Plug-in

=lolx|
File Edit Source Refactor Navigate Search Project Run  MWindow Heslp
= LE - |e|laoader |8 2%
i ld ) 1 Java Application 25 outline .
@ 2 Remote Java Application, in iSeries wisw L Welcome
7 3 Java Application in iSeries Server Overview
- aler & it Tot - [2) Dependencies
a Ju 4 JUnit Test 3
@ =) com.example.MyPlugin | Mo aler % °rg'ec:!pse'c°re‘
iy B[] MyPluginPlugin.jav. M S’Q'E“DSE'“‘
= = com.example.MyPluging |~ Gen s Jarva Baan | Applat ntime Libraries Bl nfi"w'wm;
41 sampledction.java " — LiHCCIREIE
! This section describes general information about this  The Fallowing ibraries will be added kot |5 [ Extensins
(i) +1-{3lh, ECLIPSE_HOME pluginsforg S ’
plugin classpath of this plug-in: . eclpse.ui.ad
£ +]-{3, ECLIPSE_HOME pluginsfort S 8 Ul ach
- +]- {3, ECLIPSE_HOME/pluginsjord | 9"

#1-{gy ECLIPSE_HOME/pluginsjorg | Plug-in Name:
+1- {3, ECLIPSE_HOME/pluginsford | ersion
- ECLIPSE_HOME[plugins{ont | pyo e hame

1. Select any plug-in project
ey [ 2. Use the Run As -> Run-time Workbench
e ZEtensions menu item to launch a new instance of the

Workbench with your plug-in(s) loaded.

7 Connector Project The Following exteny
7 Ta$ Dema Web Project
o5 I5eries Java Samples
1| {a# Program Call Project
o test

7T Trade

e et » Use Debug-> Run-time Workbench to
debug your plug-in

last modified . 3 .

> Set breakpoints in the Java source editor

. = path

Pacage ol Herarcy s | 4] | before or after launching the debugger

com.xample.MyPlugin

‘ Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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B ezl navigator = = = w x |[IE X
& Welcame to WebSphere Studio

This pggg kells you what you should know before you skart developing applications with WebSphere
Shudin, rimlication, Neselaney Click e binbliokbed links b oo e desrribed bk
x| L

=] @ Hello, Eclipse world
ar)

ve
ith

3 Customizing your workbench

= ou can move views and editors around the warkbench by dragging their titlebars. You can
B outine = alsa add mare views to vour current perspective by using Yindow > Show Wiew.

To reset the perspective to its original state, choose Window > Reset Perspective.

An outline is not available,

Finre s hawe areanned s nerenertie woncan sswe i sion Window s Saws Parsnarctive ni _'_I

<
Brand new copy Of 'E—leTaIsks I(n items) : : . 2 @ f: = =
i | 1 | Description Resource In Folder Location
the Workbench
running with your
plug-in

3

¥ |

R |
‘ Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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User Interface

= User Interface for plug-ins should be done using SWT and JFace
— Provides the best integration with the Workbench

= SWT is a new Java widget toolkit
— Different than AWT and Swing

= JFace is a Ul Framework built on top of SWT for creating wizards,
editors, views, dialogs, preference pages, ....

Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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User Interface

= SWT
— Fast
— Native operating system look and feel
— Provides all the common Ul widgets

— Button, Label, Menu, Menultem, ProgressBar, ...
= JFace
— Ul frameworks built on top of SWT

— Provide a higher level of abstraction so you can focus on your
added function, not Ul details
— Provide a common look and feel across all Workbench tools

— Wizards, .., preference pages all look and act the same

— Provides base set of classes you can extend to add your specific
function

W ] I. 4

Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation




IBM Software Group | WebSphere software

User Interface - JFace

= Text Framework
—  Framework for providing source (text) editors
—  Provides support for

— Content assist, syntax highlighting, formatting, ...
= Viewer Framework

— Different types of views into a data model
— TreeViewer, CheckboxTreeViewer, TableViewer, ...
= Contribution Framework
—  Framework for adding actions to the workbench toolbar and menubar
= Dialog Framework
—  Framework for creating dialogs that interact with the user
— Example classes:
— PreferenceDialog, PropertyDialog, WizardDialog, ...
— Also provides pages for using inside the dialogs
— PreferencePage, PropertyPage, WizardPage, ...

W ] I. 4
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Other Things to Consider

LG software

Add your own tools: Eclipse Plug-in Development © 2003 IBM Corporation
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HELP!!! — Lots of ways to provide help

= Tooltip help
Also known as "fly-over help”

Tooltip is shown when user hovers the mouse pointer over a menu item,
button, entry field, ...

Use the setToolTipText(String text) method on a widget
= F1 key help
Context sensitive help

Typically used to provide a short description of the current task when the
user presses F1 in a view, dialog, wizard, entry field

Set context ids using WorkbenchHelp.setHelp(...)

Eclipse then looks up the context id in HelpContexts.xml
= Full blown online help

You can provide complete online documentation integrated into the Help
perspective

This is full topic on its own

W ! I. 4
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Team Extension Points

= Version / Configuration Management
— Allows source management providers to plug into the workbench

— Can be used with by any project in the Workspace without any

additional work

— Java projects, Web projects, iSeries projects, ...

Open source CVS
implementation of the

*Debugging
<Extensibility framework

Platform APIs / Extension Points
Common Services
*Resource Management
*Project Model
*Team Programming Model

Common Frameworks
+Widget Toolkit
+Ul Frameworks
+Editing Frameworks
*Builders, Markers, Help

CVS Other

VCM APIs is provided
as a reference
implementation

1-i4

| Add you own tools | Eclipse Plug-in Development

Interface Interfaces, WebDAV

Repository

© 2003 IBM Corporation
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What about the iSeries?

LG software
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WebSphere Development Studio V5 - -
V5R1 or V5R2
5722-WDS
No-cost V4 Upgrade 5903
W
NN A
+VisualAge RPG

WebSphere Development Studio Client V5
A ¥ |

| Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation

There is now only one application development product sold by IBM, for iSeries, as of V4R5. This is
WebSphere Development Studio (Development Studio), which includes all four host compilers, all
traditional tools (ADTS = PDM+SEU+SDA+RLU+DFU+AFP+CGU), and unlimited licenses of the
workstation-based toolset named WebSphere Development Studio Client (formerly WebSphere
Development Tools).

If you are an existing customer who has a subscription, you can upgrade to Development Studio free
of charge. Without a Software Subscription, there is an upgrade fee. New licenses of Development
Studio are priced very competitive compared to the combined prices of all constituent products. As of
V5R1, there is no way to purchase the compilers or tools individually. So if you have RPG at V5R1 or
higher, you must have Development Studio and hence are entitled to Development Studio Client.

For consultants who do not have an iSeries of their own, but still wish to have the client tools,
Development Studio Client is also made available as a passport advantage product so it can be
purchased "off the shelf" from IBM Direct.

Development Studio has been a huge success, with over 80,000 licenses sold. Just as every
development machine used to have PDM and SEU, every development machine will now have all the
modern Application Development tools from IBM. This ubiquity is especially important for business
partners who build and sell software. These Business Partners are now free to build software using
any of the technologies or tools in Development Studio, and can assume their customers will have
the tools required to tailor everything from RPG to Java and Web user interfaces. This effectively
raises the lowest common denominator to a level unparalleled by any other operating system.
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RPG and COBOL Tools

= Remote Systems Explorer
— For random drill-down or filtered access to remote:
Library, objects and members in QSYS
IFS Folders and Files
Linux (including LPAR), Unix and Windows Folders and Files
Local Folders and Files
— For remote command execution of
— QSYS Commands
— QShell Commands
— Linux, Unix and Windows Commands
— For exploration of Jobs in QSYS
= iSeries Projects and Navigator
— For structured, project-based development
— Local team-sharable project
— Holds source files and source members and save files

— Push action to copy local files to associated library

W ! I. 4
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Femote System Connection
DN conmection Tormatin

Parsrk proffe: etz

Connecton names | Cevsiopren 321

s |
Hask rame:
Desoiphon: [15eries used for desvaloomant

ol

/ﬁ' TrHLge

s | wers | ]

8

‘ Add you own tools | Eclipse Plug-in Development

Remote System Explorer Perspective

= Manages connections to remote systems
— Where you create and manage connection information

— Start by using the New Connection wizard

— Connection appears in tree view
— Expand it to see "subsystem" -> functional groupings

Bl B3R Mzvge Seach Brojct Bun

— Connections subsequently used in all iSeries tools

wnoon tep

RIS

o

47 owine

x

& cutine i gt

Remote Systems View:

Shows all existing connections
Expand to drill down
Right click to do actions

= roportes

User itvaies

Frepey

(i1 i A Libeares
Ik feres Cormands

[
il gffy ieries ks
BI- s IS Fles
[

1 e Sposied Fies

Coarecd

Nerre
Nurber of chren
Fart

4l

Tone

Ranos Systens | Team
Subeysbam: ierims Objects
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iSeries Connection Properties

= Use Properties of iSeries E— Ao
Commands to set: SR
. . . . Litrery [ ]
—Library list information o Tubarromon |
—Current library
_Initi fcmore.
Initial command to call _IM_B
—Environment variables Lissbsan|
= All information is applied at
connect time
Curvent lbrary | "USRPRF -
[nbial command |
Rostore Defauts Apply
ol

Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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iISeries Connection Subsystems

= Expand a connection in the to see subsystems:

— iSeries Objects

— iSeries Commands
— iSeries Jobs

— IFS Files

Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation

iSeries Objects
Like WRKXXXPDM. For drilling down on libraries, objects, mbrs
Right click offers wealth of actions like create, rename, delete...
Can edit source members using built-in LPEX or classic CODE
Can create User Defined Actions just like in PDM
iSeries Commands
For creating command sets containing one or more CL commands
Right click and select Run to remote run commands
Results are logged in Command console
iSeries Jobs
For seeing jobs, filtered by number, user ID or status
Right click to do common actions on jobs, such as end or hold
IFS Files
For drilling down on IFS folders and files
Right click offers wealth of actions like create, rename, delete...
Can edit source members using built-in LPEX or classic CODE
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4P Remote System Explorer - WebSphere Development Studio Client Advanced Edition for iSeries =] 3}

Fle Edt Source Complle Havigate Search Project Run Window Hel Built-in Remote Systems

=3 ellgE- %I v|ls-(lee LPEX Editor
x || ForRDENTR X } utline & x
Row 117 Column 1 Replace
1 + 2 + + 4 +
DSTRCT i 011700 * =
. i EVFEWENT *file pf-dta 011800
Expand afilter S H.4ile. pi-src 011300 CSE  FgsCust EEGSR
. 012000 x :
see objects e it 012100 % Display the prompt for a customer —f <3| CSTVR : DI
. £ ORDENTD. *file. dspf 012200 [ WRITE KEY (=45 STOCK : DIt
resulting from (& ORDERS *file pf-dta 012300 & EXFHT FROMET = 1
ET sTrRcD
resolution of filter R maton - o 8 oeoens :
S PRTORDERP. e erif 012600 *  Clear srror indicators < ORDLIN :
Eh QCLSRC.*file.pf-sre 012700 [ EXSR ClrError [#-C) Data Structures
[E QDDSSRC.Hile.p-src 012800 * #-C3 Constarts
3 “filg.pf- 012300 = P th ' v
+Drill down through e s 013000 ¢ CaImis o CEEn Twon 5-C3 Indicators
Ely QPMLSRC.#File.pf-src
q q e 013100 c *THD4 CASEQ *0H B-H— Fields
libraries, and b aPNLSREP.File. pf-sr 013200 c *TN12 CASEQ *ON ). Gigs Main Procedure
. 1 Eh QRPGLESRE #file. pf-src 013300 [ ChS =03 subrowtines
source files to get 0y QROCONIT.rogle 013400 c Ee = e
[ OROENTR Dol (3200 * = ADDORDER
to member: 7y PRTORDERR.rpale 3| =]
B SLTCUSTR rpgie Verify program action completed with informational et
By SLTPARTR. rpgh e . =
rpgle q
*Right click on & ZoRoETR rpds I
: : . By ZSLTCUSTR pgle 43| iSaries Error List - <S105YMZM >\WFLAB23JQRPGLESRC(ORDENTR)
il -
libraries, objects E!% AR P == 5. tocation [ onre... |
. ey i he name or indicator CUSTLMAME... 0 72 WFLABZI/QRP... SLOSY...
-6 SLTPARTD. file. dspf 1 |RNF7031 LT
and mempers to i __ STOCK e, pfoda i RWFPO3L  Thername orindicator IDATAR mot.. 0 5 WELABZ3/QRP... S105V..
get actions 1 698} 25, TCLISTD, #fl.dspf i RWFPO3L  The name or indicator PARTPRICE (... 0 83  WFLABZO/QRP... S105V..
'r*D-: ORDEMTRPNL. *prigrp = i RNF7150  Record STRCD in file STOCK contai. a 31 wWFLABZ9/QRI 5105V,
. i RWFP085  RPGhandies blocking For fle ORDE... 0 32  WFLABZ3/QRP... S105V...
= B i handles blocking for fil 2 —
| Remote Systems ITEam Tasks |iSeries Comman. . |iSeriss Listings {\Senes Error List J Remote Comma... | Spooled Files |Properties |iSeriss Job Log

WFLABZ3fQRPGLESRCIORDENTR) MBRTVPE(RPGI

Various iSeries specific views for showing additional information.
iSeries Error List shows compile / verify errors

Add you own tools | Eclipse Plug-in bevelopment © 2UUs 1BV Gorporation
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RSE: Filters and Filter Pools

= Expand a subsystem to see "filters"

Like WRKXXXPDM generic name filters but
Are named and saved

There are some predefined
Such as Library List to see *LIBL libraries in iSeries Objects
Such as popular commands in iSeries Commands

To create your own, right click on subsystem object

Each filter can contain multiple filter strings
So you can list all libraries that start with A and B

= Eventually, you'll have too many filters
Time to turn on "Show Filter Pools" via preferences
Expanding subsystems will then first show filter pools
Filters are grouped into named pools
By default they are added to the single default filter pool
You can create your own filter pools
Then add filters to it
Expand a filter pool to see just the filters in it

W ! I‘
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iSeries Objects Subsystem Filters

= Library List filter
Displays library list
Provides popup actions for working with the library list

= Library filters
Specify simple, generic or special library names
Lists all matching libraries, when expanded

= Object filters
Specify simple or generic object names, library-qualified
Library name can be simple, generic or special
Specify simple or generic object types and attributes
Can specify one or more type:attribute pairs (OR operation)
Lists all objects that meet criteria, when expanded

= Member filters
Specify simple or generic member names, lib/file-qualified
Library name and file name can be simple or generic
Specify simple or generic member types
Can specify one or more member types (OR operation)
Lists all members that meet criteria, when expanded

W ] I. 4
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Remote Systems LPEX Editor

= Remote Systems LPEX Editor
Re-write of CODE Editor for Eclipse

= What it has today:
All base support from CODE Editor, such as:

Plus!

Alt+L/C/M/D/U/S/J to select/copy/move/delete/unselect/split/join
Select streams, lines, blocks and rectangles (Edit menu)
Command-line for directly entering editor commands
Keystroke recording for repetitive tasks

Compare utility

Rich search, find and replace

Bookmarks and quick marks

Ctrl+L to locate a line

Line-number prefix area

File->Get File to import a file

Filter Selection to only show lines containing selected text

Outline view support for ILE RPG and COBOL
Content assist for ILE RPG

W ] I. 4
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Underlying Model of the RSE

Profiles
ﬁ'
" contain
Proiiles
enable
eam
SUPPOIFi
and . ﬁ
efectiver | ic

grouping

et | 4

Filter Pools

—

Filters

contain

—_—

contain

Connections

Filter Strir:wgs

contain

ﬁ.
contain

Subsystems data

Filter Pool Referencés

er Defined Actions

Add you own tools | Eclipse Plug-in Development
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iISeries Projects Perspective

Create iSeries Create Create

Project Source File | Source Mbr

dp iSeries Projects - * =hSphere * svelopmer* _cudio Client for iSeries
Eile Edit Source Comdl [avigate Project Run  ‘Window Help

|5-E0a/lade |84 -4-[| v||%-|26|ams|apd I
iSeries Project = |iSErias Froject Navigator ~ w X W X] Il
o > © o Rov & Column 51 Replace

-2 WHOLESALE .. . DNane+++++++++++ETDsFrom+++To L+++10c . KeyvordS+++
|| = A ¥ 000300 = =
=& qppssrc 000400 ~COPY grpglesrc, cwesordpr

: W CWSTOCK, PF goosoo Dquant S Like(Qty)
Source Physical 5 Sl 000600 gert L, Lake(eraan
File T .- oroERDSP D3P 000800 LR Like(RC)
=B omusee 000900 Dprice Liks(RPric
H 0% STORE.MNUDDS 001000 C open CUSTOCE
001100 Closs CUSTOCK

£ 5% QRPGLESRC

0000 0

3]

B 001200 =
Source (2 CWWSORDDRRFGLE || gp150g c Eval quant = 100
(% CwWwSORDPR.RPGLE 001400 C Ewval part = 12345
001500 [ o Eval s = 's'
Members 001600 [« callp OrdSrvipart: quant
Al | C
iSeries Project I |
navigator: 1B Remcte Systems

expand project to || EEACRERENE
Work Wlth |Oca| - ESALE.*lib.prod-usr =

las... 30f0303&:0...
name CWW/SORDD...

oinan Remote Systems |-

i5eries Proj... |Navigatar |Bookmarks | | Remote Systems view for Praperties | Cutine

convenience |

source

W 1 1 &
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Here we see the iSeries Projects perspective, which you can explicitly
open. The primary view is the iSeries Navigator that allows exploration of
all existing iSeries Projects. There are wizards lauchable from the toolbar
for creating a new iSeries Project, or creating source physical files and
source members within an existing project. The iSeries Projects
perspective includes a full copy of the Remote Systems Explorer, as a
view, for your convenience. This allows you to easily work with the
contents of the associated library while simultaneously working with the
local copies of the source within the project.
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New iSeries Project Wizard

Choose

Giveyoeuriproject ) GCONNEGHION

New s i
dNidme friomRSENist
iSeries Project iSeries Project Properties
Create a new iSeries project that maps to an iSeries library, i Spedify the iSeties project properties. i
Project name: | WHOLESALE] Connection: [Development System | mew.
st s Associated lbrary: | WHOLESALE] ml

¥ Use default
Directory; [ CH\Dacuments and Settingslyantaiity Documents|TBMime | Browss,.,

Specify the connection and library name ko associate with this iSeriss project, The
comniction allows for remote access ko the iSeries host machine. Cods changes
made locally are pushed to the specified remate library, That library is alsa used for
performing builds on the remote host,

Specify the name and location of the iSeries project being created. An iSeries
project allows for local development, while performing builds on a remate iSeries
host machine.

<kack [ mexex || Ewh Cancel <gack | wests [[ B | canel |

ldentifipAssociated hibran/athis
isithetargetlibran/forpushes
andibuilds
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Here we see the rest of the iSeries Project wizard. First, give the project a
name. Any name you want! Then select or create a connection (from the
RSE!) that identifies the iSeries with which this project is associated. Also
select the library on that iSeries where the contents of this project will be
pushed to. Also, specify a CL command to call for the "Build" action. If you
don't have such a CL command, enter a dummy value or leave it blank.
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iSeries Project Wizard

. " . e —
Buildistyle:controlSthowtheliSeries

" . " Enter the project’s source fils thak contains the COMPILECLLE and BIND CLLE members that will be
projectisibuiitionitheremoteisystem uploaded to buld this project.

Build Source File:

| QCLSRC =
iSeries Project Properties ¥ Automatically generate COMPILE.CLLE prior to each build
Select and configure the active build styls for this projsct. e e

Active build style:

Configure. ..
SpecifyBuildiStylerand
styleconfigurationiparameters
ToriSeres Project

This build skyle will upload CL programs specified in the configuration, compile them,
and then run them ko build this project, The compile commands can be automatically
generated.

morelnformationjonnextsiides:

Provided by IBM plugin 'iSeriss Tooling - Styles Flugin” version 5.0,0

g _________Wy
<& Command Build Style Configuration
R R

Enter Ui LU E Ll this project.

<Back wee> | B | eneel || e
1

™ autematically push all changed members prior ko build
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Here we see the rest of the iSeries Project wizard. First, give the project a
name. Any name you want! Then select or create a connection (from the
RSE!) that identifies the iSeries with which this project is associated. Also
select the library on that iSeries where the contents of this project will be
pushed to. Also, specify a CL command to call for the "Build" action. If you
don't have such a CL command, enter a dummy value or leave it blank.
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iISeries Projects Build Styles

= Build Styles
Specify how to build the iSeries project on the remote system
Three IBM-supplied build styles
CL Program
Automatically generates COMPILE.CLLE and BIND.CLLE
Adds compile command for each source file in project
Uses last compile command from RSE for specified source type
i.e. CRTBNDRPG versus CRTRPGMOD

At build time these two members are pushed to iSeries, compiled and
run

Command
You specify single command to run build
Good if you have an existing build script
*NONE
No build support

= |SVs can plug-in additional build styles
To work with their existing iSeries systems

© 2003 IBM Corporation

Add you own tools | Eclipse Plug-in Development

Here we see the wizard for creating a new iSeries source physical file.
Within the project, this is actually a folder. When the project is pushed to
its associated library, this result in a CRTSRCPF command being run to
create a file with the attributes specified in this wizard.
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Project "Bleedthrough”
dpiSeries Projects - WebSphere Development Studio Client for iSeries o) x|
File Edit Source Comple Mavigate Search Project Bun Window Help
IS-ERe|laae |81 -%-[|s]l%-[les | mmeail
= B o v x || 4/ CWWSORDDR.RPGLE X}
% B Row 6 Colunn 51 Replace
- .. .DHane+++++++++++ETDsFront++To L+++10c . KeywordB+++++++++++4
i) e * =
3 New * loo #COPY grpalesrc,cwwsordpr
% % Golto oo Dguant S Like(Qtvy)
e i » (00 Dpart 7 Like(ProdHo)
Oy | 00 o= 5 34
’E s Open in lew Windaw 00 DR = Like({RC)
£ T Dprice 5 Like(RPrice)
C open CWSTOCK
- _—
c Ewal quant = 100
C Ewal part = 12345
0 ¢ 5 et oo g Eval s = 's'
ry - 00 C callp OrdSrv(part: quant: =: R:
Moye. ., oo i DSPLY price =
Rename
e R | 3
Impart. .,
. Export. ..
Currently showing
Close Prajact te Systems w x || Properties ’E;-‘% B x
onlylocal Rerech
e N [ =t Property [ value |
IESOUNGES Remate Actions P E-jl, WHOLESALE. Mib.prod-usr = E‘Infnd. :
R = & edi... true
Team » CWWISORDDR. *pgm.rpale los... 30/03/03 8:2...
o CWWSORD. *srvpgm.rpgle
Compare With 3 2l CHISRY. *srvpam. pale name WHOLESALE
Rieplace it v . EPamIPS - I;l path | fWHOLESALE
. Restore From Local History. ..
iSeties Projeck b ——————————————————————pystems J Tasks Il Propetties J Qutline
—_— e |

A ¥ |
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Here we see an iSeries project in the iSeries Navigator, within the iSeries
Projects perspective, that has a number of local files and members.
Right-clicking on the project or anything in the project, gives a popup menu
with the all-important "Show Remote Objects" menu item....
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Local and Remote Objects

&P iSeries Projects - WebSphere Development Studio Client for iSeries iseries Prﬂ-eﬁl Ilil"ialllr:
Eile_: Edit Source Compile .mawgate. Search Project Run  Window Help |0Ca| ﬁles and members
ll=] lladad [ -x-||s|x-]les] “UselPushipopupimenuiaction
E =85 et v x || #CWWSORDDR.RPGLE X} to copy, from project to Ilbrary
me > © e Row 6 Colunn 51 . J .
| = @ wowsae . “UseiBuilditolbuildiproject =
J nnning /COPY grpglest ~Use Tieam=>Syncitoicopy,
@ E-E§ qDDssre e  joo Dgquant y
@ ¥ cws  Golto 00 Dpart to/from)team yepository
LB mwer GeTe & i
E (& orot | Bpen i eH IR i - TEMOLEION]ECLS) flles 2ndmirs
L b nRenote e (00 -UseAdd to Projectito.copy. ~ i
-8 QUEF gopy o from|librarytoiproject
[RE T 00 ¢
&R 8 =
T e - & [REmoteI==r]
B IMENTO Tmport. . onlylexisisiin associated ibrarny
g v MR {local/Remptel=>" ==
- 'g Engiw— pte Systems | exists locally/anadliniassociated b
o 8 CWPWSOR ko { elj=> r=m
B oo - local{nemo el
: E.t- CWHSSR Compars With i conflicubetweenilocal and remote
cad CWWSSR Rerlace With i ISp= |
Restore From Local Hiskory... - ' M
5] e onlyzexistsiocally
i5eries Project Navigew— - -
Local Ohject: WHOLESALEJQCLSRC

N J ¥ |
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Once "Show Remote Objects" is enabled (it is a toggle) all the objects in
the associated library for this project are shown in the iSeries Navigator.

This navigator is called a "bleed through" view because it lists both local
files/members and remote objects, files and members. However, if a file or
member exists both locally and remotely, it is not shown twice. Rather, it is
only shown once, and its icon and bracketed text identify it as existing in
both places.

The icons and text enable you to see at a glance which files/members
exist only locally, only remotely, or both locally and remotely. In the latter
case, the color of the icon indicates if the two are in synch or not. If not, it
is an indication you need to "push" your local source to the associated
library to get it in synch.
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iISeries Projects Remote Build

= Submit Build
Submits build of iSeries project on remote system
Adds build job to iSeries Build Job Status view

Jobiwherebnld
ISUnning Statusiofithelbuild

&5 x

& iSeries Build Job Status

DatefTime Submitked
30-Mar-03 9:2%:02 PM

Job

| Project | Status |
923621 /VANTZIVANTZL WHO Faal F Finished

30-Mar-03 9:30:08 PM 923623 VANTZIYANTZT Cance! Queued
Retrieve Errors

Remove

[Eof _*|refresh Tnterval: 10 seconds

Refreshiinterval Retrievelerrorsifrom
determineshowirequently; builditoithe
statiisisiipdated iSeries Errorlbist:

AN J ¥ |
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Once "Show Remote Objects" is enabled (it is a toggle) all the objects in
the associated library for this project are shown in the iSeries Navigator.

This navigator is called a "bleed through" view because it lists both local
files/members and remote objects, files and members. However, if a file or
member exists both locally and remotely, it is not shown twice. Rather, it is
only shown once, and its icon and bracketed text identify it as existing in
both places.

The icons and text enable you to see at a glance which files/members
exist only locally, only remotely, or both locally and remotely. In the latter
case, the color of the icon indicates if the two are in synch or not. If not, it
is an indication you need to "push" your local source to the associated
library to get it in synch.
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Remote System Explorer Extension Points
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Additional documentation on the following extension points can be found in:

C:\WDSCl\iseries\eclipse\plugins\com.ibm.etools.systems.core_5.0.0\plugin.xml
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Benefits of Building On Top of the RSE

= What does the RSE offer you?
Extension points for remote objects
Popup menus
Property pages
Extend the remote system framework
Add a new subsystem
Add a new system type
iSeries, Linux, Unix, Windows and Local are pre-supplied
Java APIs for accessing remote systems
Native
Retrieve lists of libraries, objects, members and jobs based on filters
Retrieve properties for a library, object, member or job
Prompt and run commands
Run applications in batch or interactive
IFS / Windows / Linux / Unix
Retrieve lists of directories / files
Run remote commands

W ] I. 4
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Adding a New RSE System Type

= Extension point
com.ibm.etools.systems.core.systemtype

= Adds a new system type to the Remote Systems Framework
The new system type will appear in the new connection wizard
No Java code required!
You can then add new subsystems for this type

<extension point="com.ibm.etools.systems.core.systemtype">
<type name="Windows"
iconlive="icons/windowsL.ive.gif"> icon changes

icon="icons/windows.gif"> when system
9 R is connected
</type>

or
disconnected

ON | -
W ] ¥ |
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Adding New Subsystems

= Extension point
com.ibm.etools.systems.core.subsystemfactory

A SubSystemFactory creates instances of a specific type of
subsystem

= Adds a new subsystem
New subsystem will appear under connections of specified type

<extension point="com.ibm.etools.systems.core.subsystemfactory">
<factory

systemtypes="iSeries"
name="Files"
icon="icons/filesubsys.gif"
iconlive="icons/filesubsyslive.gif"
id="com.acme.etools.mypkg.myfactory"
class="com.acme.etools.mypkg.MyClass"

category= ﬁleS" Class must implement the
vendor="acme"> com.ibm.etools.systems.subsystems.SubSystem
</factory> Factory
T | 1 @ interface
‘ Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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Adding Property Pages for Remote Objects

= Extension point
com.ibm.etools.systems.core.propertyPages

= Add property pages for remote objects

Property pages will appear in the properties dialog when user selects
"Properties..." from the popup menu for a remote object

<extension point="com.ibm.etools.systems.core.propertyPages">
<page class="com.acme.myPropertyPage"
id="com.acme.mypropertypage"
name="Remote File Info" -Filters are subsystem specific
icon="icons/myProperties gif' -Each remote object can have a

subsystemfactoryid="ibm.filesLocal"
typecategoryfilter="files" — type, subtype and subsubtype
typefilter="file" ~For example

subtypefilter="java" Type: *PGM
namefilter="* java"> Subtype: RPGLE

: | o ~Can also filter by name

Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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Adding Popup Menu Actions for Remote Objects
= Extension point
com.ibm.etools.systems.core.popupMenus
= Add action for remote objects

New action will appear in the popup menu of remote objects in the
Remote Systems view

Example —>

Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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Adding Popup Menu Actions for Remote Objects

<extension point="com.ibm.etools.systems.core.popupMenus">
<objectContribution
id="com.acme.displayfile.actions"
subsystemfactoryid="ibm.files400"
typecategoryfilter="OBJECT*"
typefilter="*FILE"
subtypefilter="DSPF" Same as property
namefilter="*"> pages
<menu id="com.acme.disptayfitemrme
label="My Display File Actions">
<separator name="group1"/> Adds the
</menu> menu item
<action id="com.acme.action1"
label="My first action"
class="com.acme.actions.Action1"
menubarPath="com.acme.displayfile.menu/group1"
enablesFor="1">
</action>
<action id="com.acme.action2"
label="My second action"
class="com.acme.actions.Action2"
menubarPath="com.acme.displayfile.menu/group1"
enablesFor="+">
</action>
</objectContribution>

s 1 I. l

Your actions

‘ Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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SoftLanding Systems, Inc. WDSC, includes:

&P Remote System Explorer - 1M WebSphere Studio Application Developer
Fle Edt Mavigate Search Project Run Window Help

Free Spooled File Plug-in for

- Spooled files subsystem

- Spool files filtering

= SEIEEEREAEE - -
- Spooled files table view
- x ORDEMTR_041573_YAMTZI_QPRTIOB_1.bxt
iz || X
2P E <2 = (P L I VIR - Perform remote actions on
i} SLESERM - 1
B g s Comnand spooled files
i serles Obfects Issued by . . A YANTZI
&% iSeties Commands
B i5eries Jobs Program CORDENTR
¥, IFS Files
88 iSeries Spocled Files Library DEMODY
o -
Bl Vour spoaled files Text 'description’ . . . :  xSRCMBRTHT
i G 3
B OFFLINE,— — "
QFFLTE, 65 mofresh ber . .. . : ORDENTR
B OFFLINE Expand e QRPGLESRC
B oFRLINE [ e
B OFFLIME - DEMODY
OFFLINE: sy oo o
B OFFLINE =
B oFrLing: % Delete | - - - : =|
OFFLINE.
OFFLINE, S TGt SR x
B OFFLINE e, .
B orrine. SR
OFFLINE: Change
OFFLINE: Mave
T
Remote Systems | Taam g ligw |iSeries Commands Log |Properties {SearchJ ft
Relegse L ‘ www.softlanding.com
Messages(B)

¥ |
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SoftLanding Systems, Inc.

Spooled File Filter

Create a new filer to list spocled files

User; B

output queue: [
Library: B

User data: *

Form type: *

Define your own filters for

showing spooled files

= Bach

[ e |

fsh | caned |

Device or Queus | User Data Status

GGPLIGPRINT
QEPLIQPRINT
QGRLIQPRINT
QGPLIGPRINT
QEPLIQPRINT
QGRL/QPRINT
QGPLIQPRINT
QGPLIQPRINT

HREADY
FREADY
FREADY
+READY
FREADY
HREADY
HREADY
HREADY

- x
Total Pages | Current P... | User [ 308 Job Wumber | File Mumb =
WANTZT QPADEVD 17571 1
YANTZT QPADEVD.., 917406 1
YANTZT QPADEVD... 917406 z
VANTZD QPADEVD... | 917406 3

‘ Add you own tools | Eclipse Plug-in Development

Spooled files view shows details
about each spool file and provides
right click popup menu actions
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Plug-in Development Summary
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Summary

= Eclipse and the WebSphere Studio Workbench provide:
An integrated development environment
Extendable platform

You can focus on your function without worrying about:
Resource management
Help system

Rich set of base classes for quickly developing Ul

= WDSc provides:
iSeries tooling plugged into Eclipse
Remote Systems Framework
With extension points so you can add functionality to the RSE

W ] I. 4
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Additional Resources
= Eclipse
www.eclipse.org

= WebSphere Development Studio Client
http://www.ibm.com/software/awdtools/iseries//

= |IBM’s developerWorks
www.ibm.com/developer

s 1 I. l
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Disclaimer

= Acknowledgement:
This presentation is a collaborative effort of the IBM Toronto AS/400 Application
Development presentation team, including work done by:

Phil Coulthard, George Farr, Claus Weiss, Don Yantzi, John Steinbacher,
David Slater, Alison Butteril, Linda Cole
= Disclaimer:

The information contained in this document has not been submitted to any formal
IBM test and is distributed on an as is basis without any warranty either express
or implied. The use of this information or the implementation of any of these
techniques is a customer responsibility and depends on the customers' ability to
evaluate and integrate them into the customers' operational environment. While
each item may have been reviewed by IBM for accuracy in a specific situation,
there is no guarantee that the same or similar results will result elsewhere.
Customers attempting to adapt these techniques to their own environment do so
at their own risk.

= Reproduction:

The base presentation is the property of IBM Corporation. Permission must be
obtained PRIOR to making copies of this material for any reason.
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